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About this guide
This document is a global document. Contact your system supplier or your 
Nortel Networks representative to verify that the hardware and software 
described are supported in your area.

Target audience
The DECT OA&M guide provides information for planners, installers, site 
maintenance personnel, and administrators. It contains administration 
programs and maintenance information about the DECT system.

Identifying Nortel Networks PBX systems
The following systems are referred to in this guide as large systems:

• Option 51

• Option 61

• Option 71

• Option 81

• Option 51C

• Option 61C

• Option 81C

The following systems are referred to as small systems:

• Option 11

• Option 11E

• Option 11C
DECT Operation Administration and Maintenance
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• Option 11C Mini

• Succession Communication Server for Enterprise 1000

Call out boxes

CAUTION:  Data loss
This symbol advises of a procedure that can result in a loss of data.

CAUTION:  Electrostatic sensitive device
This symbol advises of a procedure that can result in equipment damage 
due to ElectroStatic Discharge (ESD).

DANGER:  Electric shock
This symbol advises of the risk of a serious injury, or death, caused by an 
electric shock.

DANGER:  Serious injury
This symbol advises of the risk of a serious injury, or death, caused by an 
immediate hazard.
553-3601-301    Standard 5.00 September 2002
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OA&M Introduction

Contents
This section contains information on the following topics:

Optivity Telephony Manager DECT Application. .. . . . . . . . . . . . . . . . 12
DECT Application features. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Common Services features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
OTM navigators. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Features available to Windows-based navigators. . . . . . . . . . . . . 14
Features available to both Windows and web-based navigators. . 14

Reference list
The following are the references in this section:

• Using Optivity Telephony Manager (553-3001-330)
DECT Operation Administration and Maintenance
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Optivity Telephony Manager DECT Application
The Optivity Telephony Manager (OTM) provides a single point of access 
and control for managing various Meridian 1 and Succession CSE 1000 
applications.

OTM provides a DECT Application and OTM Common Services to manage 
a DECT system. OTM runs on Windows NT 4.0, Windows 98, and Windows 
2000 as a server plus Windows 95 as client.

Note:    For an overview of OTM, see Using Optivity Telephony Manager 
(553-3001-330).

DECT Application features
The DECT Application provides the following DECT managing features and 
allows a user to:

• launch the Application from OTM using Windows navigators and web 
navigators

• view the DECT System provisioning with the DECT Systems window

• view the DMC8 configuration with the Boards window

• view base station configuration with the Radio Fixed Part window

• view subscription information with the Subscriptions window

• upgrade Firmware using the DECT Systems window

• subscribe handsets using the Subscription window

• support DMC-8 and DMC (serial only)

• synchronize (update) the DECT Application database to the DECT 
system configuration when the OTM connects to the DECT system

• collect performance data using the Performance Collection window

• view On-line Help
553-3601-301   Standard 5.00 September 2002



OA&M Introduction Page 13 of 196
Common Services features
The following DECT management features are provided by the OTM 
Common Services:

• OTM Alarm Management provides alarm collection and alarm 
processing, and the following:

— a web-based alarm browser used to view alarms, past alarms and 
occurring alarms

— a Windows-based alarm browser used to view only those alarms that 
occur while the browser is open

— an Alarm Notification application that signals an alarm occurrence 
by pager or E-mail, and can forward the alarm to an upstream 
processor

— a PC Event log and Viewer used to view events and alarms 
generated from the DECT Application in a report layout.

• Backup and restore makes a OTM backup file of the DECT application 
data.

• User profiles enable configuration of different types of DECT users.

• On-line help provides help for common service features.

For more information about the Common Services features, see Using 
Optivity Telephony Manager (553-3001-330).

OTM navigators
There are two navigators used with the DECT application to manage a DECT 
system:

• a Windows® based navigator

• a web-based navigator

A Windows-based navigator that uses the Microsoft Windows interface can 
access all DECT application features. A web-based navigator, that uses the 
Web (http) interface, can access most, but not all, DECT application features.

Use the Windows-based navigator if a DECT system is managed at an OTM 
server.
DECT Operation Administration and Maintenance
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A web-based navigator must be used if a DECT system is managed from a 
client PC. 

Features available to Windows-based navigators
The following features are only available at an OTM server using the 
Windows-based navigator. The OTM server can do the following:

• define DECT system si te s

• define Meridian 1 system

• configure handsets with the Station Administration feature of OTM

• OTM Alarm Notification

• PC Event log and Viewer

• backup and restore the DECT Manager database to and from a file

• define a user profile for Windows-based applications

• define user management for Windows-based applications

Features available to both Windows and web-based navigators
Provisioning features
The following provisioning features are available using either a 
Windows-based navigator or a web-based navigator:

• define DECT system

• DECT system names

• DECT Concentration mode

• DECT system Access Right

• Transmission parameters

• DMC8 provisioning

• Firmware provisioning

• Base Station provisioning
553-3601-301   Standard 5.00 September 2002
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Operation features
The following operation features are available using either a Windows-based 
navigator or a web-based navigator:

• DECT system connectivity

• DECT system connection control

• Read data from a DECT system on demand

• Define handsets with the overlays in the OTM database

• Define handsets in the DECT database

• Subscribe handsets

Maintenance features
The following maintenance features are available using either a 
Windows-based navigator or a web-based navigator:

• Operational status monitoring

• Alarm management

• Date and Time

• Upstream Manager IP address

• basic browser

• DECT system data synchronization with the DECT Manager database

• performance

• PC Event Log

Security features

For information about the Security features, see Using Optivity Telephony 
Manager (553-3001-330).
DECT Operation Administration and Maintenance
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DECT system administration
Contents

This section contains information on the following topics:
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Reference list
The following are the references in this section:

• Using Optivity Telephony Manager (553-3001-330)

• Option 11C Customer Controlled Backup and Restore (CCBR) 
(553-3011-330)

• DECT Overview (553-3601-103)

• DECT Programming and Provisioning Record (553-3601-250)

Windows access to the DECT application
For access from a web-based browser, see “Web-based browser access to the 
DECT application” on page 24.

Login to the OTM

Figure 1
OTM login dialog box 
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Complete the following steps. 

Table 1
Login to the OTM

Step Action

1 Access the OTM Login dialog box.

Click on Start>Programs>OTM.

2 Login.

Enter User ID, Password, and click OK. 

END
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Select the Meridian 1 PBX that supports the DECT system

Figure 2
OTM Navigator window

Complete the following step.

Table 2
Select the Meridian 1 PBX that supports the DECT system

Step Action

1 Select the Meridian 1 system.

Double click on XXX (shown as Sample System in Figure 2). 

END
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Launch the DECT Application

Figure 3
M 1 System Window

Complete the following step.

Table 3
Launch the DECT application

Step Action

1 Launch the DECT application.

Double click on DECT, or pull-down File menu and click DECT.

END
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Web-based browser access to the DECT application
For more detailed information on web-based browsers, see Using Optivity 
Telephony Manager (553-3001-330).

MS Internet Explorer and VeriSign Digital Certificates
If using Internet Explorer as a web browser on Windows NT4 Server, 
Windows NT4 Workstation or Windows 9x platforms, it is necessary to 
import the Verisign Class 3 certification into the client authentication 
repository.

The Verisign certificates must have the same characteristics, including 
expiration date. The certificates are used to sign the OTM DECT applet. The 
Verisign certificates must be in the Internet Explorer certificate store so that 
the Java Plug-in 1.2.2 can recognize the OTM DECT certificate.

If the OTM DECT certificate is not recognized, the system generates a Fatal 
navigational error.

To install the certificates, perform the following steps:

1 Using the web browser, follow the steps in Table 5 on page 25 to log on 
to the OTM server.

2 Ensure that the JRE (Java) version is the same (minimum JRE 
1.2.2_006). To do this, at a command prompt on both the client and 
server side, enter 

java -version

3 At the web client PC use the web browser to go to the following URL:
http://server_name/omdect/VeriSignCertificates.
html

4 Click the VeriSign Class 3 certificates link. 
A screen appears, asking if the VeriSignClass3CA.p7b file is to be saved, 
and where to save it.

5 Save that file to the local PC being used. 

6 Right-click on the file. From the pop-up menu that appears, select Install 
Certificate to import the certificate. 

7 An Installation Wizard appears. Click Next until installation is complete.
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8 Connect to the OTM server using the Web Client, and log in. Launch 
OTM DECT for normal access.

Note: This procedure applies only to Internet Explorer web browsers. It 
is not applicable to Netscape.

Open the Web Administrator Login
Table 4
Internet Explorer and Netscape Communicator

Complete the following steps.

Table 5
Open the Administrator Login

Step Action

1 Open a Web browser.

Click on Internet Explorer icon or Netscape Communicator icon.

2 Open the Administrator login screen.

Enter the URL http://<otm_server_name>/admin or use the ip_ address. 

END
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Web Administrator Login

Figure 4
OTM web Administrator Login

Complete the following steps.

Table 6
Open the OTM web Administrator Login

Step Action

1 Select the Administrator Login.

Click on the applet launch logo.

2 Login.

Enter User Login , Password, and click Submit. 

END
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Open the Web current Status

Figure 5
OTM web navigator current Status

Complete the following step.

Table 7
Open the current Status

Step Action

1 Open System Navigator screen.

Click on System Navigator in the Equipment list on the left. 

END
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Open the web System navigator
The System navigator is selected by clicking on System Navigator in the list 
on the left of the screen shown in Figure 5 on page 27.

Figure 6
OTM web System navigator
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Complete the following steps. 

DECT Systems window

Figure 7
DECT Systems window

Table 8
Open the web System navigator

Step Action

1 Select a DECT system.

Highlight a system in the Systems list.

2 Open the DECT systems window.

Click on OTM DECT in the grey box on the left.

END
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Open Subscriptions, Boards, and RFP windows

Connection to a DECT system
Complete the following steps. 

Table 9
Open Subscriptions, Boards, and RFP windows

Step Action

1 Select a DECT system.

Highlight a system from the list.

2 Open one of the following from the DECT Systems window:

• Subscriptions window

• Boards (DMC) window

• Radios (base station) window

Click on the appropriate entry in the Applications pull-down menu. 

Table 10
Connection to a DECT system  (Part 1 of 2)

Step Action

1 Select a DECT system from the DECT Systems window list.

Highlight a DECT system.

2 Perform one of the following actions from the DECT Systems window:

1 connect to a DECT System

2 disconnect from a DECT System

3 lock a connection to a DECT System

4 unlock a connection from a DECT System

END
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Note: While the Connection status is Connecting or Disconnecting, the 
Connect/Disconnect tool is disabled. The status bar shows the 
connection progress.

From the Applications pull-down menu click on the following items, or click on the 
following icon:

1 Connect  or  (green)

2 Disconnect  or  (yellow)

3 Lock  or  (red)

4 Unlock  or  (yellow)

Note:  See DECT Systems window in DECT Overview (553-3601-103) for a description 
of connections. 

Table 10
Connection to a DECT system  (Part 2 of 2)

Step Action

END
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Permanent connection to a DECT system

Figure 8
DECT Systems window and DECT System Properties window
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Complete the following steps. 

Table 11
Permanent connection to a DECT system

Step Action

1 Select a DECT system from the DECT Systems window list.

Highlight a DECT system.

2 Connect to a DECT System.

From the Applications pull-down menu, click on Connect or click on the  (green) 
icon.

3 Open the Properties dialog.

From the File pull-down menu, click on Properties.

4 Select Permanent Connection.

Check the Permanent Connection box.

5 Accept the changes.

Click on the OK button.

END
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Add DECT systems
Add new site properties

Figure 9
New Site Properties
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Complete the following steps:

Table 12
Add New Site Properties

Step Act ion

1 Open the New Site Properties window.

In the OTM Windows Navigator, choose Add Site from the Configuration menu.

2 The Site Name appears in the Navigator tree. The Short Name is an abbreviated site 
name that displays in the Alarm Banner.

Enter the Site Name and Short Name.

Note:  Bold fields in the dialog sheets indicate required information.

3 In the Site Location box.

Enter the Site Location information.

4 In the Contact Information box.

Enter the contact name and related information, and click Apply.

5 To add a new system to this site.

Click Add System. 

6 When the Site information is entered, click one of the following buttons to add the site 
to the Navigator tree.

OK adds the site and closes the property sheet.

Apply adds the site and leaves the property sheet open allowing another system to be 
added to this site (repeat step 5 to add another system).

Cancel closes the dialog box without adding the site.

END
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Add the Meridian 1 PBX on the OTM server
As many systems (including non-Meridian 1 systems) as the license permits 
can be added to a site. Administrator privileges are required to add a system.

Figure 10
Add System

Complete the following steps:

Table 13
Add the Meridian 1 PBX on the OTM server  (Part 1 of 2)

Step Act ion

1 In the Navigator window, select the site.

If adding a new system from within the New Site Properties window, go to step 3 in this 
procedure.

2 Open the Add System dialog.

Choose Add System from the Configuration menu or the right mouse button pop-up 
menu.
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3 Program the Add System dialog box.

It might be necessary to install additional software to enable other system types not 
listed here. Follow the installation instructions included with the order.

Select the system type, and then click OK.

Table 13
Add the Meridian 1 PBX on the OTM server  (Part 2 of 2)

Step Act ion

END
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Add the Meridian 1 PBX properties – general tab

Figure 11
New System Properties – General tab
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Complete the following steps:

Table 14
Add the Meridian 1 PBX properties – General

Step Act ion

1 Select the General tab.

Click the System Properties – General tab.

2 Program the System Name and Short Name (required fields), and other information 
as needed.

Enter the System Name and Short Name.

3 System Location and Contact Information can be the same as site information.

Click the Same as Site checkbox.

4 Accept changes.

Click the OK button.

END
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Add a Communications Profile for the DECT application

Figure 12
Add Communications Profile

Complete the following steps:

Table 15
Add new Meridian 1 PBX Communications Profile  (Part 1 of 2)

Step Act ion

1 In the Navigator window, select the Sample Site.

Double click on Sample Site.

2 Choose the Properties dialog.

Click on Properties from the File menu.

3 Open the Add Communications Profile dialog.

Click on the Communications tap and click Add.

4 Select a communications type.
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Highlight Ethernet in the Type box.

Note:  The DECT application does not use the Communications Profile. Unless there is 
another application that requires a specific Communications Profile, choosing Ethernet 
is the least complicated profile to implement.

5 Program the Profile Name.

Enter a Profile Name.

6 Accept the changes.

Click OK.

Table 15
Add new Meridian 1 PBX Communications Profile  (Part 2 of 2)

Step Act ion

END
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Add the Meridian 1 PBX System Data Properties

Figure 13
System Properties – System Data tab
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Complete the following steps:

Table 16
Add the Meridian 1 PBX System Data Properties

Step Act ion

1 Select the system Data tab.

Click the System Properties – System Data tab.

2 Program the Machine Information.

Enter the Machine type and Release version for the system. 

Note:  For example, if the Meridian 1 is an Option 61C running Release 25 software, 
enter 61C in the Machine field and use the drop down box to select 25 in the Release 
field.

3 Program the System Parameters.

Enter the appropriate values for the system.

4 Program Packages.

Enable or disable M1 packages as appropriate for the system.

5 Note:  This data can be copied directly from an installed switch by scheduling an upload 
with the File menu Update System Data command in the System window. Update 
System Data uses the communication profile for Station Administration. However, 
configure the Release number here first to allow available applications to appear 
properly in the Applications Tab.

END
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Add the Meridian 1 PBX System Applications Properties
This tab defines the OTM applications that will appear in the System window 
and the communications profile to be used with each application. An 
application must be enabled for it to be available in the System window.

Figure 14
System Properties – Applications
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Complete the following steps:

Add the Meridian 1 PBX Customer Properties
This tab lists the customers currently defined for this Meridian 1 system. The 
following action can be performed:

• add new customers

• delete customers

• review the properties of a selected customer

When a new customer is added, configure the Meridian 1 features and 
numbering plans that are available to the customer. This information is not 
automatically updated on the Meridian 1. It must be updated by using LD 15 
Customer Data Block.

Table 17
Add the Meridian 1 PBX System Applications Properties

Step Act ion

1 Select the system Applications tab.

Click the System Properties – Applications Data tab.

2 To enable an application.

• Select the application in the Applications box.

• Select a Communications Profile from the drop-down list in the Selected 
Application box.

• A checkmark appears next to the application and the Enabled box is also checked.

3 To disable an application.

• Select the application in the Applications box.

• In the Selected Application box, click the Enabled checkbox to remove the 
checkmark.

END
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Note: Customer information is required for System 
Administration/CPND and ESN applications.

Figure 15
System Properties – Customers

Complete the following steps:

Table 18
Add the Meridian 1 PBX customer properties  (Part 1 of 2)

Step Act ion

1 Select the system Customers tab.

Click the System Properties – Customers Data tab.
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Add the Meridian 1 PBX Customer0 General Properties

Figure 16
Customer0 Properties – General

2 Select a customer number.

Click OK.

3 Update the Meridian 1 PBX.

Use LD 15 Customer Data Block.

Table 18
Add the Meridian 1 PBX customer properties  (Part 2 of 2)

Step Act ion

END
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Complete the following steps:

Table 19
Add the Meridian 1 PBX Customer0 General Properties

Step Act ion

1 Select the General tab.

Click the General tab.

2 Program the Customer Name and Number.

Enter the Customer Name and Number.

3 Program the Home Location Code.

Enter the HOLC as defined in LD 90.

4 Program the Scheduler System ID, if using applications with scheduled activities, 
such as Station Administration/CPND, ESN, and Traffic.

5 Accept changes.

Click Apply.

END
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Add the Meridian 1 PBX Customer0 Features Properties

Figure 17
Customer 0 Properties – Features
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Complete the following steps:

Table 20
Add the Meridian 1 PBX Customer0 Features Properties

Step Act ion

1 Select the Features tab.

Click the Features tab.

2 Program Features Group.

3 Accept changes.

Click Apply.

END
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Add the Meridian 1 PBX Customer0 Numbering Plans
Properties

Figure 18
Customer Properties – Numbering Plans
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Complete the following steps:

Note: At this point the DECT application is installed in the OTM server.

Table 21
Add the Meridian 1 PBX Customer0 Numbering Plans Properties

Step Act ion

1 Select the Numbering Plans tab.

Click the Numbering Plans tab.

2 Program the customer information appropriate for the Meridian PBX.

3 Accept changes.

Click one of the following buttons to save the information:

• OK adds the customer and returns to the System properties sheet.

• Apply adds the customer and leaves the Customer properties open so that other 
information can be added for this customer.

• Cancel closes the dialog box without adding the customer.

END
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Delete DECT systems

Figure 19
DECT Systems window

Complete the following steps.

Table 22
Delete DECT systems  (Part 1 of 2)

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.
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3 Select a DECT System to delete.

Highlight a DECT system from the list.

4 Delete the DECT System.

From the File pull-down menu, click on Delete.

Table 22
Delete DECT systems  (Part 2 of 2)

Step Action

END
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Configure non-concentrated handsets on a Meridian 1 PBX
For information about System Administration, see Option 11C Customer 
Controlled Backup and Restore (CCBR) (553-3011-330)

Open Station Administration window

Figure 20
M1 System Window

Complete the following step.

Table 23
Station Administration window 

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M 1 System Window.

END
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Access Add Station window

Figure 21
Station Administration window

Complete the following steps. 

Table 24
Access Add Station window

Step Action

1 Access Add Station window.

From the Edit pull-down menu, click on Add.

END
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Add 500 analog standard

Figure 22
Add Station window

Complete the following step.

Table 25
Add 500 analog standard

Step Action

1 Add 500 analog standard.

Highlight 500 Analog Standard, and click on the OK button.
END
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Access features

Figure 23
500 dialog
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Complete the following step.

Access wireless type

Figure 24
Features window

Table 26
Access features

Step Action

1 Access features.

Click on the Features button.

END
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Complete the following step.

Select wireless type

Figure 25
Wireless window

Complete the following step.

Table 27
Access wireless type

Step Action

1 Access wireless type.

Highlight Wireless Type, and click on the Select button.

Table 28
Select wireless type

Step Action

1 Select wireless type.

From the Wireless Type (WTYP) pull-down menu, click on YES.

END

END
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Select DECT wireless set

Figure 26
Wireless window

Complete the following step.

Table 29
Select DECT wireless set

Step Action

1 Select DECT handset.

From the Wireless Type (WTYP) pull-down menu, click on DECT Wireless Set, and 
click on the OK button.

END
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Accept changes

Figure 27
Features window

Complete the following step.

Table 30
Accept changes

Step Action

1 Accept changes.

Click on the Done button.

END
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Configure concentrated handsets on a Meridian 1 PBX
Open Station Administration window

Figure 28
M1 System Window

Complete the following step.

Table 31
Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the Meridian 1 System Window.

END
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Access Add Station window

Figure 29
Station Administration window

Complete the following step.

Table 32
Access Add Station window

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.

END
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Select Digital Cordless Set

Figure 30
Add Station dialog

Complete the following step.

Table 33
Select Digital Cordless Set

Step Action

1 Select Digital Cordless Set.

Highlight DCS, and click on the OK button.
END
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Select Features

Figure 31
DCS window

Complete the following step.

Table 34
Select Features

Step Action

1 Select features.

Click on the Features button.
END
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Select wireless type

Figure 32
Features window

Complete the following step.

Table 35
Select wireless type

Step Action

1 Select wireless type.

Highlight WTYP, and click the Select button.

END
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Select Visit DECT Set or local calling

Figure 33
Wireless Visiting DECT Set

Complete the following steps.

Table 36
Select Visit or local  (Part 1 of 2)

Step Action

1 Select Visit DECT Set as Yes if this handset is visiting this Meridian 1 PBX. Select No 
if this handset is to be configured for local calling only.

If Visiting DECT Set is Yes, go to step 2. If the handset is configured for local calling 
only, go to step 4.

2 Select visiting

From the Visiting DECT Set (VSIT) list, select Yes.

3 Select a Home DN.

Enter a DN in the Home Directory Number (HMDN) box.
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Select an index

Figure 34
Features window

4 Configure for local calling only. 

From the Visiting DECT Set (VSIT) list, select No.

5 Accept changes.

Click on the OK button.

Table 36
Select Visit or local  (Part 2 of 2)

Step Action

END
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Complete the following step.

Provision hardware

Figure 35
Hardware Provisioning window

Table 37
Select an index

Step Action

1 Select an index.

Highlight INDX, and click on the Select button.

END
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Complete the following steps.

Table 38
Provision hardware

Step Action

1 Select a DMC TN.

Enter a TN in the DECT Mobility Controller (DMC) box.

2 Select an index.

Enter an index in the Index on DMC (INDX) box. 
(Index range is 0 to 509.)

Note:  The Terminal Number (TN) is a virtual TN and is selected by the Meridian 1 PBX 
system.

Note:  Index 0 – 509 on Meridian 1 is seen as Index 1 – 510 in OTM.

3 Accept changes.

Click on the OK button.

END
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Accept changes

Figure 36
Features window

Complete the following step.

Table 39
Accept changes

Step Action

1 Accept changes.

Click on the Done button.

END
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Single line features

Figure 37
500 window

Complete the following step.

Table 40
Single Line Features

Step Action

1 For information on other Single Line Features.

Refer to the OTM Station Administration in Using Optivity Telephony Manager 
(553-3001-330).

END
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Retrieve subscription data for handsets

Figure 38
 DECT Subscriptions window, Synchronize DECT and Administration Config window
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Complete the following steps:

Table 41
Retrieve subscription data for handsets

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Retrieve the subscription configuration data from the OTM Station Administration 
database.

In the Subscriptions window, click on the Operations pull-down menu, click on 
Retrieve OTM Configuration.

5 Note:  At this point, all handsets configured on OTM Station Administration are shown 
in the Subscriptions window

Open the Configure DECT Subscription dialog.

Click the File pull-down menu. Click Add or .

END
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Enable subscription

Figure 39
Subscriptions window

Complete the following steps for each handset:

Table 42
Enable handsets

Step Act ion

1 Note:  At this point, there are no PINs shown in the Subscriptions window.

Select a handset from the list.

Click on one handset in the list to highlight a row.

2 Enable handsets.

Click on the Operations pull-down menu. Click Enable or click on .

END
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Activate the PIN on the handsets

Figure 40
Subscriptions window

Complete the following step:

Note: When a handset is subscribed, the Subscription window shows the 
Status column as Subscribed and does not show a PIN.

Table 43
Obtain the PIN

Step Act ion

1 Note:  At this point, in the Subscriptions window, the PINs are shown and the Status is 
Enabled.

Subscribe the C4010, C4010Ex, C4040, and C4050 handsets.

See “C4010, C4010 Ex, C4020 handset subscription” on page 78,and “C4050 handset 
subscription” on page 85.

Enabled

PIN

END
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C4010, C4010 Ex, C4020 handset subscription

Figure 41
C4010 handset and C4010 Ex handset

Distribute C4010, C4010 Ex, C4020 handsets and install
 battery chargers

Consult the work order for a list of handset users and their locations.

DANGER:  Serious injury

Never charge a C4010Ex battery in an explosive atmosphere.
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Figure 42
Battery details, charger details, and connections
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Complete the following steps.

Table 44
Install battery charger and charge batteries 

Step Act ion

1 Take the  handset package to the user location.

2 Unpack the  handset and its accessories, as applicable.

3 Insert the handset battery pack, as applicable.

Note:  Use only the approved battery for the C4010 Ex handset.

4 Unpack the  handset battery charger and its accessories.

5 Mount the battery charger.

Place the charger on the desk, or mount the charger on the wall, as applicable.

Note:  Never mount a battery charger in an explosive atmosphere.

6 Install the mounting screws. Use screws with a maximum diameter of 
4 mm.

Turn the two screws into the wall at a distance of 45 mm from each other. Make sure 
that the screw heads protrude by 2.5 to 3 mm. 

7 Hang the charger on the screws.

8 Install the power supply.

Plug the power supply cable into the connector located on the side of the charger, then 
plug the ac adapter into the 230 V ac mains socket. 

9 Place the handset into the charger.

Note:  The battery icon appears on the handset display screen indicating the battery is 
charging, whether the battery is installed or not.

END
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Subscribe the C4010, C4010 Ex, C4020 handset
Consult the work order for a list of subscription names.

Complete the following steps.

CAUTION:  Service interruption
Charge the C4010, C4010 Ex, and C4020 battery at least 12 hours before 
using the handset for the first time. This will ensure maximum battery life.

Table 45
C4010, C4010 Ex, C4020 handset subscription 

Step Act ion

1 Select Language.

2 Select Declare base.

Press the Declare base  key.

3 Declare base number? 12345678.

Press the Ok  key.

4 Enter code refers to the PIN code.

Note:  The Subscriptions screen displays the PIN. The PIN is only valid for 16 minutes.

Enter the PIN.

To delete the last digit that was entered, press Erase, or select the digit and enter a 
new digit.

Press the Ok  key.

END
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Table 46
Handset name and DN identity 

Step Act ion

5 Select Menu.

Press the Menu  key.

6 Select Handset name.

Dial 86.

7 Enter the Handset name and/or the handset DN to identify the handset.

To enter a character, press keys 0 to 9 as shown in Table 47 on page 83. For example, 
to enter E press the 3 key twice. To move to the next character, pause three seconds. 
To delete a character, press Erase, or select the digit and enter a new digit.

Note:  Handset DNs are programed in LD 10, not in the DECT database.

8 Confirm the name and DN.

Press Ok.

END
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Use the Southern handset keypad alphabet equivilent listed in Table 47 for 
the following languages:

• English

• French

• German

• Dutch

• Spanish

• Italian 

Table 47
Southern handset key pad alphabet equivalent 

Key 1 2 3 4 5 6 7 8 9

0 0

1 – / space 1 , . : ,

2 A B C 2 Á À Ä ß

3 D E F 3 É È

4 G H I 4 í ì

5 J K L 5

6 M N O 6 Ñ Ö Ó Ô

7 P Q R S 7

8 T U V 8 Ü Ú

9 W X Y Z 9
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Use the Northern handset key pad alphabet equivilent listed in Table 48 for 
the following languages:

• English

• Portuguese

• Swedish

• Norwegian

• Finnish

• Danish

Table 48
Northern handset key pad alphabet equivalent 

•

Key 1 2 3 4 5 6 7 8 9

0 0

1 – / space 1 , . : ,

2 A B C 2 Å Ä Ã Á Æ

3 D E F 3 Ê

4 G H I 4

5 J K L 5

6 M N O 6 Ö Ó Ô

7 P Q R S 7

8 T U V 8 Ú

9 W X Y Z 9
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C4050 handset subscription

Figure 43
C4050 handset

Distribute C4050 handsets and install battery chargers
Consult the work order for a list of handset users and their locations.

553-A0079
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Figure 44
Battery details, charger details, and connections

Complete the following steps.

Table 49
Install battery charger and charge batteries  (Part 1 of 2)

Step Act ion

1 Take the handset package to the user location.

2 Unpack the handset and its accessories, as applicable.

3 Insert the handset battery pack, as applicable.

Note:  Use only the approved battery for the C4050 handset.

4 Unpack the handset battery charger and its accessories.

5 Mount the battery charger.

Place the charger on the desk.

6 Install the power supply.

553-A0080
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Subscribe the C4050 handset 
Consult the work order for a list of subscription names.

Complete the following steps.

Plug the power supply cable into the connector located on the side of the charger, then 
plug the ac adapter into the 230 V ac mains socket. 

7 Place the handset into the charger.

Note:  The LED ring on the handset is green when the batteries are charging.

CAUTION:  Service interruption
Charge the C4050 battery at least eight hours before using the handset for 
the first time. This will ensure maximum battery life.

Table 50
C4050 handset subscription  (Part 1 of 2)

Step Act ion

1 Select Menu. 

Press Menu. 

2 Select System.

Scroll to System. Press OK. 

3 Select Subscription. 

Table 49
Install battery charger and charge batteries  (Part 2 of 2)

Step Act ion

END
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Press OK. 

4 Select Options. 

Scroll to New. Press OK. 

5 Enter PARK if two DECT systems overlap. 

Press OK. 

6 Enter the PIN code.

Note:  The Subscriptions window displays the PIN. The PIN is only valid for 15 minutes.

Enter the PIN code.

7 Enter the system name.

8 Enter the handset DN.

9 Enter the handset users name.

Table 50
C4050 handset subscription  (Part 2 of 2)

Step Act ion

END
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Note: Complete the DECT Programming and Provisioning Record 
(553-3601-250).

Table 51
Handset key pad alphabet equivalent

Key 1 2 3 4 5 6 7 8 9 10 11

0 0 space @ $ &

1 1 ? ! , . : ; “ ‘

2 A B C 2 Ä Å À Á Ã Æ ç

3 D E F 3 È É Ê Ë

4 G H I 4 ì í Î Ï

5 J K L 5

6 M N O 6 Ñ Ö Ò Ó Ô Õ Ø

7 P Q R S 7 ß

8 T U V 8 Ü Ù Ú Û

9 W X Y Z 9

* * - + = ~ < > ^ %

# # ( ) { } [ ] / \ _
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Disable a handset subscription

Figure 45
DECT Subscriptions window and Disable DECT Subscription window

Note: For further information, refer to “Disable subscriptions” in DECT 
Overview (553-3601-103) and “Multi Site Mobility Networking” in 
DECT Overview (553-3601-103).
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Complete the following steps.

Table 52
Disable handset subscription

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Select a handset subscription(s) for disabling.

Note:  A single handset, a list of handsets, or all handsets on a DMC can be selected.

Highlight a DMC TN and an Index, or several indexs in the list.

5 Disable the handset subscription(s).

From the Operations pull-down menu, click Disable.

6 Disable from this system only.

Click OK.

7 Disable from all systems where the portable set is subscribed.

Click OK.

END
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Copy a handset subscription

Figure 46
DECT Subscriptions window and DECT Copy Subscription window

Note: For further information, refer to “Copy Subscriptions” in DECT 
Overview (553-3601-103)
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Complete the following steps.

Table 53
Copy handset subscription

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Select the source DECT system to copy the subscription.

Highlight the DECT system in the DECT Systems window.

4 Open the Subscriptions window.

Follow the instructions on page 29.

5 Open the DECT Copy Subscription dialog.

From the Edit pull-down menu, click on Copy.

6 Select a DECT system where the copied subscription will be put.

Pull-down the Destination DECT System list and highlight a system name.

7 Select DMC on the DECT system where the copied subscription will be put.

Pull-down the Destination DMC list and highlight a DMC.

8 Select a handset subscription(s) to copy.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index (or more than one index) in the list.

9 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index (or more than one index) in the list.

10 Accept the changes.

Click on the OK button.

END
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Move a handset subscription

Figure 47
DECT Subscriptions window and DECT Move Subscription window 

Note: For further information:, refer to “Move Subscriptions” in DECT 
Overview (553-3601-103).

Move

Move
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Complete the following steps. 

Table 54
Move handset subscription

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Open the DECT Move Subscription dialog.

From the Edit pull-down menu, click on Move.

5 Select a DECT system where the moved subscription is to be put.

Pull-down the Destination DECT System list and highlight a system name.

6 Select DMC on the DECT system where the moved subscription is to be put.

Pull-down the Destination DMC list and highlight a DMC.

7 Select DMC on the DECT system the moved subscription is to be put.

Pull-down the Destination DMC list and highlight a DMC.

8 Select a handset subscription(s) to move.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index (or more than one index) in the list.

9 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index (or more than one index) in the list.

10 Accept the changes.

Click OK.

END
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Find a handset subscription

Figure 48
DECT Subscriptions window and Find DECT Subscription window 

Note: For further information, refer to “Find subscriptions” in DECT 
Overview (553-3601-103).
553-3601-301   Standard 5.00 September 2002



DECT system administration Page 97 of 196
Complete the following steps. 

Table 55
Find handset subscription

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Open the Find DECT Subscription dialog.

From the Edit pull-down menu, click on Find.

5 Select find criteria.

Click on Find IPUI or Find Home DN, enter the value, and click on the Find button.

6 View the results.

END
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Import a handset subscription

Figure 49
DECT Subscriptions window and DECT Import Subscription window

Note: For further information, refer to “Import subscriptions” in DECT 
Overview (553-3601-103).
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Complete the following steps.

Table 56
Import handset subscription

Step Action

1 Access the DECT Application.

Follow the instructions in “Windows access to the DECT application” on page 20.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Open the DECT Import Subscription dialog.

From the File pull-down menu, click on Import.

5 Select a DECT system where the imported subscription is to be put.

Pull-down the Destination DMC list and highlight a DMC.

6 Select DMC to be imported.

Pull-down the Destination DMC list and highlight a DMC.

7 Select a handset subscription(s) to import.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index, or several indexs in the list.

8 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexs in the list.

9 Accept the changes.

Click OK.

END
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Export a handset subscription

Figure 50
DECT Subscriptions window and Export Subscription window

Note: For further information, refer to “Export subscriptions” in DECT 
Overview (553-3601-103).
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Complete the following steps.

Table 57
Export handset subscription

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Open the Export DECT Subscription dialog.

From the Find pull-down menu, click on Export.

5 Select a handset subscription(s) to export.

Note:  A single handset, a list of handsets, or all handsets on a DMC can be selected.

Highlight a DMC TN and an Index, or several indexs in the list.

6 Select a DMC or Index for the subscription(s).

Highlight a To: DMC TN or a To: Index, or several To: indexs in the list.

7 Accept the changes.

Click on the OK button.

8 Paste the subscriptions into a file.

.

END
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Force disable handset subscription

Figure 51
DECT Subscriptions window and Force disable DECT Subscription window

Note: For more information, refer to “Force disable” in DECT Overview 
(553-3601-103).
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Complete the following steps.

Table 58
Force disable handset subscription

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Open the Force Disable DECT Subscription dialog.

From the Operations pull-down menu, click on Force Disable.

5 Select a handset subscription(s) for Force Disabling.

Note:  Select a single handset, a list of handsets, or all handsets on a DMC.

Highlight a DMC TN and an Index (or more than one index) in the list.

6 Disable the handset subscription(s).

From the Operations pull-down menu, click on Force Disable.

7 Disable from this system only.

Click on OK button.

8 Disable from all systems where the portable set is subscribed.

Click OK.

END
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Deleting TNs that are not on the switch
To remove configured sets (TRN status) that are no longer on the switch, 
perform the following steps:

Note: Perform this procedure after 500 analog TNs have been converted 
to concentrated TNs.

Step Action

1 Using Windows, log in to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Use a web-based navigator to open the Administrator login screen and log in. Select 
the System Navigator. Select the Meridian 1 that supports the DECT system. Launch 
the DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the Subscriptions window.

Follow the instructions on page 29.

4 Open the DECT Move Subscription dialog.

From the Edit pull-down menu, click Global update.

5 Select the sync status SSTAT.

Set Old value to the current status. Set New value to NEW.

6 Delete the TN’s from the switch..  

END
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Update data on OTM or update data on a DECT system

Figure 52
Mismatch dialogs
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When the DECT manager connects to a DECT system, synchronization flags 
any differences between the DECT manager database and the DECT system 
database with mismatch dialogs. These dialogs are useful when provisioning 
DECT systems off-site. 

See “Provision a DECT system remotely” on page 107, and “Subscribe a 
DECT system remotely” on page 110.

Complete the following steps.

Table 59
Update data on OTM

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Select a DECT system.

Highlight a DECT system from the list.

4 Connect to a DECT System.

From the Applications pull-down menu, click on Connect or click on the  (green) 
icon.

5 If any of the dialogs in Figure 53 on page 107 appear, it is necessary to decide to 
update either the DECT manager or the DECT system.

Click on either the Update DECT Manager button, or Update DECT System button.

END
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Provision a DECT system remotely
A distributor can use a DECT System in the distributor’s premises lab to 
configure a system and subscribe sets on it. If the DECT Access System and 
board configuration are the same on both the distributor’s and the customer’s 
DECT Systems, and if the handsets are properly programmed on the customer 
Meridian side, then the DMCs can be placed in the customer’s system and 
the handsets will function properly.

Remote DMC8 provision where the customer site
has a DECT manager

Figure 53
Remote DMC8 provision where the customer site has a DECT manager
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DECT Manager
DECT Manager

6b – Back up
DECT Access
System data
into the DECT
Manager

6b - Synchronize 
from the DMC

then

synchronize to
the DMC
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Complete the following step.

Table 60
Remotely provision where the customer site has a DECT manager

Step Action

1 Remotely provision DMC8s for a customer site.

Follow the steps 1 to 6a/6b shown in Figure 53 on page 107.

END
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Remote DMC8 provision where the customer site
does not have a DECT manager

Figure 54
Remote DMC8 provision where customer site does not have a DECT manager

Complete the following step.

Table 61
Remote DMC8 provision where the customer site does not have a DECT manager

Step Action

1 Remotely provision a customer site.

Follow steps 1 to 6 shown in Figure 54 on page 109.

4 – Ship the
boards/DECT Access
System
5 – Ship the portable sets

DECT Access
System

End-customer premises

DECT Access
System

1 – Create a system
as the target system
(PARI, …)
2 - Launch the
Subscription

Distributor premises

D
M
C

3 – Subscribe
sets on-air

DECT Manager

6 – Update
connectivity
settings

4 – Ship the
boards/DECT Access
System
5 – Ship the portable sets

DECT Access
System

End-customer premises

DECT Access
System

1 – Create a system
as the target system
(PARI, …)
2 - Launch the
Subscription

Distributor premises

D
M
C

3 – Subscribe
sets on-air

DECT Manager

6 – Update
connectivity
settings

END
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Subscribe a DECT system remotely
A handset can subscribe itself to any DECT System, regardless of the DECT 
system Primary Access Rights Identifier (PARI) and Secondary Access 
Rights Identifier (SARI). In other words, from the handset itself, the handset 
can be subscribed to a DECT System where the handset is not necessarily 
intended to be operational. The customer may or may not have a DECT 
manager on site. 

Remote handset subscription where the customer site
has a DECT manager

Figure 55
Remote handset subscription where the customer site has a DECT manager  

3 – Export
subscription to
file
4 – Remove
subscription
from DECT
Access System

5 – Ship the portable set
6 – Ship the subscription file

Distributor DECT
Access System
with PARIdistributor
SARIdistributor

End-customer premises

End-customer DECT
Access System with
PARIcustomer
SARIcustomer

1 - Launch the
Subscription with
PARK= SARIcustomer

Distributor premises

S
et

2 – Subscribe
set on-air

DECT ManagerDECT Manager

7 – Import
subscription
from file

3 – Export
subscription to
file
4 – Remove
subscription
from DECT
Access System

5 – Ship the portable set
6 – Ship the subscription file

Distributor DECT
Access System
with PARIdistributor
SARIdistributor

End-customer premises

End-customer DECT
Access System with
PARIcustomer
SARIcustomer

1 - Launch the
Subscription with
PARK= SARIcustomer

Distributor premises

S
et

2 – Subscribe
set on-air

DECT ManagerDECT Manager

7 – Import
subscription
from file
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Complete the following step. 

Table 62
Update IP address on OTM

Step Action

1 Remotely provision a customer site.

Follow steps 1 to 7 shown in Figure 55.

END
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Remote handset subscription where the customer site
does not have a DECT manager

Figure 56
Remote handset subscription where customer site does not have a DECT manager

Complete the following step.

Table 63
Update IP address on OTM

Step Action

1 Remotely provision a customer site.

Follow steps 1 to 4 shown in Figure 56.

3 –Ship the portable set

Distributor
DECT Access
System with
PARIdistributor
SARIdistributor

End-customer premises

End-customer
DECT Access
System with
PARIcustomer
SARIcustomer

1 - Launch the
Subscription with
PARK=
SARIcustomer

Distributor premises

S
et

2 – Subscribe
set on-air

DECT Manager

4 – Move
subscription

3 –Ship the portable set

Distributor
DECT Access
System with
PARIdistributor
SARIdistributor

End-customer premises

End-customer
DECT Access
System with
PARIcustomer
SARIcustomer

1 - Launch the
Subscription with
PARK=
SARIcustomer

Distributor premises

S
et

2 – Subscribe
set on-air

DECT Manager

4 – Move
subscription

END
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Change passwords

Figure 57
DECT Systems window and Change DECT Password

Note: For lost passwords, see “Password recovery” on page 187.
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Complete the following steps.

Table 64
Change passwords

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator., Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the General tab.

4 Select Change Password.

Click on the Change Password button.

5 Change the password.

Enter the Old Password, enter the New Password, confirm the New Password, and 
click OK.

END
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Change the DECT system name

Figure 58
DECT Systems window and DECT System Properties – General tab
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Complete the following steps.

Table 65
Change the DECT system name

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the General tab.

4 Change the DECT system name.

Enter the new name in the DECT System Name box.

END
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Change IP address on OTM DECT manager
Before changing the IP address on the OTM DECT manager, close the 
connection. After the change on the DECT system, open the connection as a 
safety check.

Figure 59
DECT Systems window and DECT System Properties – Communication tab
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Complete the following steps.

Table 66
Change the IP address on the DECT system

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the Communication 
tab.

4 Select Ethernet.

Click on the Ethernet radio button.

5 Accept the changes.

Click OK.

END
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Change IP address on the DECT system DMC8 Relay card
Before changing the DMC8 Relay card’s IP address through Telnet, close the 
connection. After the change on the DECT system, open the connection as a 
safety check.

Figure 60
Telnet 192.168.1.1
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Complete the following steps:

Table 67
Change the IP address on DECT system DMC8 Relay card

Step Act ion

1 Open the Telnet dialog.

Click on Start>Accessories>Telnet.

2 Enter user name and password.

Type user name dasuser and password dasuser.

3 When the connection prompt local appears, change the DMC8 Relay card address.

Enter the following command: 

ipconfig xxx.xxx.xxx.xxx yyy.yyy.yyy.yyy zzz.zzz.zzz.zzz

xxx.xxx.xxx.xxx = new IP address of the DMC8 Relay card.

yyy.yyy.yyy.yyy = subnet mask, usually 255.255.255.0

zzz.zzz.zzz.zzz = IP address if this is the gateway for the network.

Note:  Set zzz.zzz.zzz.zzz to the IP address of the OTM server Ethernet interface. If 
there are two Ethernet interfaces on the OTM server, set zzz.zzz.zzz.zzz to the IP 
address of the interface, which is on the same network as the DMC8 Relay card.

END
553-3601-301   Standard 5.00 September 2002



DECT system administration Page 121 of 196
Change a PARI or SARI
Note: When the PARI or SARI changes, the DECT system resets and 
the connection closes. If the connection is permanent, the OTM manager 
attempts to open in the background.

Figure 61
DECT Systems window and DECT System Properties – Access tab
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Complete the following steps.

Table 68
Change a PARI or SARI

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties, and click on the Access Right 
Identification tab.

4 Change the PARI or SARI.

Enter the PARI or SARI.

5 Accept the changes.

Click on the OK button. 

END
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Change the Upstream Manager IP address
Note: An upstream manager IP address can only be programmed on the 
DMC8 Relay card.

Figure 62
DECT Systems window and DECT System Properties – Alarm tab
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Complete the following steps.

Table 69
Change the Upstream Manager IP address

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties. Click the Alarm tab.

4 Change the Upstream Manager IP address.

Enter the Upstream Manager IP address.

5 Accept the changes.

Click on the OK button. 

END
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Change time and date
The time and date is used to time stamp the alarms.

Note: The time and date must be changed when the DECT system 
reboots or a DMC resets.

Figure 63
DECT Systems window and DECT System Properties – Alarm tab
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Complete the following steps.

Table 70
Change time and date

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on, page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Connect to a DECT System.

From the Applications pull-down menu click on Connect or  (green).

4 Open the DECT Systems Properties dialog.

From the File pull-down menu, click on Properties. Click the Alarm tab.

5 Change the time and date.

Enter the Date and Time.

6 Accept the changes.

Click the OK button. 

END
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Change parameters

Figure 64
DECT Systems window and DECT System Properties – Parameters tab
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Complete the following steps.

Keep or remove non-operational DMC8 cards
from OTM

Note: Figure 65 on page 129 only appears when a connection is 
established and there is a mismatch. If there is a permanent connection 
and the DECT system configuration changes, the OTM DECT manager 
is updated automatically. The change is noted in the OTM event log.

Table 71
Change parameters

Step Action

1 Using Windows, log in to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on, page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the DECT System Properties dialog.

From the File pull-down menu, click on Properties. Click the Parameters tab.

4 Change the parameters.

From the appropriate pull-down menus, highlight the parameter time/level.

5 Accept the changes.

Click the OK button. 

END
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Figure 65
Synchronize DECT Board Configuration window

Complete the following steps.

Table 72
Keep or remove non-operational DMC8 cards from OTM

Step Action

1 To keep DMC8 cards,

Delete the check mark from the appropriate box.

2 To remove DMC8 cards,

3 Put a check mark in the appropriate box.

4 Accept the changes.

Click the OK button. 

END
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Keep or remove non-operational base stations
from OTM

Note: Figure 66 only appears when a connection is established and there 
is a mismatch. If there is a permanent connection and the DECT system 
configuration changes, the OTM DECT manager is updated 
automatically and the change is noted in the OTM event log.

Figure 66
Synchronize DECT Radio Fixed Part Configuration window
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Complete the following steps.

Table 73
Keep or remove non-operational base stations from OTM 

Step Action

1 To keep base stations,

Delete the check mark from the appropriate box.

2 To remove base stations,

Put a check mark in the appropriate box.

3 Accept the changes.

Click the OK button. 

END
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Resolve a subscription configuration mismatch
Note: Figure 67 appears when subscriptions are enabled with the 
Subscriptions window Operation pull-down menu, clicking on 
Configure, and not also configuring the handset on the 
Meridian/Succession with Station Administration.

Figure 67
DECT Subscriptions Configuration Mismatch window, and DMC window
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Complete the following steps.

Table 74
Select login options

Step Action

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 23.

2 Using a web-based navigator, open the Administrator login screen and login. Select the 
System Navigator. Select the Meridian 1 that supports the DECT system. Launch the 
DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28.

3 Open the DMC window.

Follow the instructions on, page 29.

4 Store DMC changes from the DECT system in the OTM server,

In the Synchronization pull-down menu, click on Synchronize From.

5 Make OTM server changes to the DMCs in the DECT system, 

In the Synchronization pull-down menu, click on Synchronize To.

END
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User Access security
Web-based navigator Access security

Group access to DECT OA&M features or handset subscriptions can be 
allowed or denied with the Web Access security window.

Figure 68
OTM Web Access security
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Complete the following steps.

Table 75
Web-based navigator Access security

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 24 to page 28. 

2 Select Web Navigator Access.

Click on Web Navigator Access. 

3 Follow the on-screen instructions. 

A check in the Allow Access column boxes permits access for the selected users 
group. No check in the boxes denies access to the selected users   group.

END
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Windows Access security
Allow or deny Group access to DECT OA&M features with the Windows 
Administration – Template Properties dialog.

Figure 69
OTM Navigator, OTM Users, and Template Properties
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Complete the following steps.

Table 76
Windows Access security

Step Act ion

1 Using Windows, login to OTM to open the OTM Navigator window. 

See “Login to the OTM” on page 20. 

2 Open the OTM Users window. 

From the Security pull-down menu, click on OTM Users. 

3 Open the Template Properties. 

From the Configuration pull-down menu, click on User Templates. 

4 Select the appropriate access level for the user group. 

Click the left mouse button on the icon to change the access, as follows: 

 – Read and write access 

 – Read only access* 

 – No access 

Note:  * Choosing read only access allows read and write access.

END
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Troubleshooting
Disconnecting

The passwords on a DMC8 Relay card and a system on the OTM DECT must 
match.

The default password for both a DMC8 Relay card and an OTM DECT 
system is Arsenal.

If the password on a DMC8 Relay card is not the same as the OTM DECT 
password, OTM will not be able to connect to the relay card. If the DMC8 
Relay card is rebooted, the mismatched password will be accepted for only 
five minutes. Then the card will disconnect again.

To solve the problem, ensure the password on the system in OTM DECT and 
the password on the DMC8 Relay card are the same. 

It is recommended that the passwords be reset to the default Arsenal.

To change the OTM DECT password, see “Change passwords” on page 113.

Note: Select the option “Do not change password on the DECT system”.

To change the password on the DMC8 relay card, see “Password recovery” 
on page 187.

Note: Do not select the option “Do not change password on the DECT 
system”.

Unable to connect with Web Client
For more information, see “MS Internet Explorer and VeriSign Digital 
Certificates” on page 24, if unable to connect to OTM DECT with Internet 
Explorer.
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190
DECT System maintenance
Contents

This section contains information on the following topics:

Alarm Code maintenance actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
Windows Alarm Snapshot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Web Alarm browser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
Windows Alarm Notification. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Event Monitor window. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

LED status for DMC8/DMC8-E and base station. .  . . . . . . . . . . . . . . . 154

Remove and insert a DMC8 for maintenance. . . . . . . . . . . . . . . . . . . . . 157
Backup a DMC8 configuration and subscription information. . . . . . 158
 Remove a faulty DMC8. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
Insert a serviceable DMC8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Restore subscription data to the serviceable DMC8. .  . . . . . . . . . . . 163

Add a DMC8 to an DECT system. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
Reuse a DMC8 in another DECT system. .. . . . . . . . . . . . . . . . . . . . 166

Remove and re-install a base station for maintenance. .  . . . . . . . . . . . . 167
Mute alarms on a base station. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
Cancel mute alarms on a base station. .. . . . . . . . . . . . . . . . . . . . . . . 168
Disconnect and /Re-install a base station. . . . . . . . . . . . . . . . . . . . . . 169

Firmware upload and activation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Recover from a Firmware upload failure. .  . . . . . . . . . . . . . . . . . . . . . . 172

Current RSSI Data. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
RSSI file format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Start/stop User Performance Collection, Equipment 
Performance Collection. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
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Equipment Performance Collection. . . . . . . . . . . . . . . . . . . . . . . . . . 180
User Performance Collection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184
Statistical Performance Data. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

Set parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186

Password recovery. .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

Reference list
The following are the references in this section:

• Using Optivity Telephony Manager (553-3001-330)

• DECT Installation Guide (553-3601-203)

Alarm Code maintenance actions
Alarm Codes can be viewed with one of the following:

• Windows Alarm Snapshot (page 143)

• Web Alarm browser (page 150) 

• Windows Alarm Notification (page 151) 
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Windows Alarm Snapshot 

Figure 70
Alarm Snapshot window and Alarm Properties window 

Note: The Alarm Snapshot window is a static display. The Alarm 
Snapshot window only shows the alarms present at the time the window 
was opened. The window must be refreshed for an up-to-date display.
The web-based alarm browser displays alarm history and occurring 
alarms.
DECT Operation Administration and Maintenance



Page 144 of 196 DECT System maintenance
Complete the following steps.

Note: The Windows Alarm Notification browser (page 151) only 
displays alarms that have occurred since the window was opened. The 
Web Alarm browser (page 150) has a circular log that provides 
information on a limited history of alarms. The Web Alarm browser 
records alarms at all times.

Table 77
Alarm Code maintenance actions

Step Act ion

1 Using Windows, and login to OTM. Select the Meridian 1 that supports the DECT 
system. Launch the DECT application. Open the DECT Systems window. Open the 
Current Alarms window.

Follow the instructions on page 20 to page 30.

2 Refresh the Alarm Snapshot window.

Click on the  icon.

3 Examine the alarm code, and take the appropriate maintenance action.

See Table 79 on page 151.

END
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Table 78
Alarms  (Part 1 of 5)

Alarm
code

Alarm description Maintenance act ion

DMC8 operational state Synthesis

DCT001 All DMC8 cards are operational.
(DCT001 only displayed in the 
Alarm browsers. DCT001 does not 
show in the Alarm Snapshot list.)

Information only, no action needed.

DCT002 At least one DMC8 card is not    
operational.
(DCT002 only displayed in the 
Alarm browsers. DCT002 does not 
show in the Alarm Snapshot list.)

Remove the DMC8 and insert the DMC8 
again to reboot. If the reboot fails, replace 
the DMC8.

Note:  When at least one DMC8 card becomes inoperable, DCT002 appears in the alarm browser 
history. When all the DMC8 cards become operational again, DCT001 appears in the browser 
history.

Presence of an alarm 

DCT101 No alarms.
(DCT101 only displayed in the 
Alarm browsers). 

Information only, no action needed.

DCT102 1 DCT102 displayed in the Alarm 
browsers is an alarm on a 
DMC8.

2 DCT102 displayed in the Alarm 
Snapshot is an alarm on a base 
station.

1 Open the Alarm Snapshot window for 
alarm details and perform the 
corresponding maintenance actions.

2 Look for one or more DCT202 to 
DCT215 alarms in the Alarm Snapshot 
window, and perform the corresponding 
maintenance actions.

DCT103 Base station alarm muted when no 
alarms. Look for one or more 
DCT501 alarms for details.(DCT103 
only displayed in the Alarm 
Snapshot window.)

Configure the base station using the OTM, 
or disconnect the base station.

DCT104 Faceplate cable alarm(s) on DMC8. 
Look for one or more DCT302 to 
DCT307 alarms for details.(DCT104 
only displayed in the Alarm 
Snapshot window.)

Perform the DCT302 to DCT307 
maintenance action.
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DCT105 Software alarm(s) on DMC8. Look 
for one or more DCT401 to DCT403 
alarms for details. (DCT105 only 
displayed in the Alarm Snapshot 
window.)

Perform the DCT402 to DCT407 
maintenance action.

Base station alarms

DCT201 No base station alarm.
(DCT201 only displayed in the 
Alarm browsers.)

Information only, no action needed.

DCT202 Local receiver signal missing (base 
station disconnected).

If a re-connection does not solve 
the problem, one of the following 
could be the cause:

1 the base station

2 the base station’s DMC8 card(s)

3 a cable problem between the 
base station and a DMC8 card.

Disconnect the base station for 30 seconds. 

1 Replace the base station.

2 Replace the base station’s DMC8.

3 Check the faceplate cabling.

DCT203 Local loss of receiver slot 
synchronization.

Perform the DCT202 maintenance action.

DCT204 Local loss of receiver frame 
synchronization.

Perform the DCT202 maintenance action.

DCT205 Local bit error rate bad. Perform the DCT202 maintenance action.

DCT206 Remote receiver signal missing. Perform the DCT202 maintenance action.

DCT207 Remote loss of receiver slot 
synchronization.

Perform the DCT202 maintenance action.

DCT208 Remote loss of receiver frame 
synchronization.

Perform the DCT202 maintenance action.

DCT209 Remote bit error rate bad. Perform the DCT202 maintenance action.

DCT210 Synthesizer out of synchronization. Perform the DCT202 maintenance action.

DCT211 Power amp out of order. Perform the DCT202 maintenance action.

DCT212 Round-trip delay changed. Perform the DCT202 maintenance action.

Table 78
Alarms  (Part 2 of 5)

Alarm
code Alarm description Maintenance act ion
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DCT213 RFP synthesizer type changed. Perform the DCT202 maintenance action.

DCT214 LFC out of synchronization with 
BMC.

Disconnect and reinsert the DMC8.

DCT215 Error due to synchronization-port 
mutation.

Can affect the interpretation of the alarm 
snapshot or alarm browser applications; 
however, the alarm should clear 
automatically within 200 seconds.

Faceplate cable alarms

DCT301 No faceplate cable alarm.
(DCT301 only displayed in the 
Alarm browsers.)

Information only, no action needed.

DCT302 The DMC8card is working; 
however, there is a loss of faceplate 
cable synchronization.

Remove all the DMC8s. Check the strap 
setting on the DMC8s. Check the faceplate 
cabling. Reinsert all the DMC8 cards.

If the above procedure does not solve the 
problem, try to find which DMC8 card gives 
the error condition by inserting the DMC8 
cards one at a time with a minute in 
between insertions.

If needed, replace the defective DMC8 card 
or the defect faceplate cables.

DCT303 No faceplate cable synchronization 
found.

The DMC8 card responsible for this 
alarm cannot pass the alarm on to 
the DMC8 Relay card.

Perform the DCT302 maintenance action.

DCT304 The DMC8 card is working; 
however, someone connected a 
faceplate cable section to the 
DMC8, causing a counter  
di f ference.

Do not connect faceplate cables to a DMC8 
on an active DECT system.

DCT305 The DMC8 card is working; 
however, there is a timing signal 
loss within the DMC8.

Perform the DCT302 maintenance action.

Table 78
Alarms  (Part 3 of 5)

Alarm
code Alarm description Maintenance act ion
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DCT306 The DMC8 card is working; 
however, the input of the faceplate 
cable controller is locked.

Perform the DCT302 maintenance action.

DCT307 The DMC8 card is working; 
however, the processor is 
overloaded with too many faceplate 
cable messages, causing an I/O 
transmit overflow.

Perform the DCT302 maintenance action. If 
the DCT302 action does not solve the 
problem, try provisioning an additional 
DMC8.

Software alarms

DCT401 The DMC8 card is working; 
however, there is a subscription 
database corruption.

In the Boards window, Synchronize From 
the DMC8, then Synchronize To the 
DMC8.

DCT402 The DMC8 card is located in a card 
slot position that does not match the 
DMC8 card subscription data card 
slot address. The mismatch is due 
to one of the following:

• the DMC8 card is placed in the 
wrong card slot position

• the DMC8 card will not come 
into service

Perform the DCT401 maintenance action.

DCT403 Duplicate subscription in the 
system.

A subscription is moved from a 
source DMC8 card to a destination 
DMC8 card; however, the original 
subscription is still present on the 
source DMC8 card.

The DCT403 alarm should always 
come from both the source and 
destination DMC8 cards.

Perform the DCT401 maintenance action. If 
the problem does not clear, look for 
duplicated subscription IPUI in the 
Subscription Property dialog. Delete the 
unnecessary subscription from the source 
DMC8.

Table 78
Alarms  (Part 4 of 5)

Alarm
code Alarm description Maintenance act ion
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DCT404 (DCT404 only displayed in the 
Alarm browsers.) One of the 
following events   occurred:

• the power was turned on

• the DMC8 was inserted into the 
shelf backplane

• a software exception restarted 
the DMC8

If this alarm was caused by a software 
exception, examine the alarm browsers for 
details.

Radio Fixed Part alarm muted

DCT501 Alarms are muted in the RFP 
window, however the base station 
does not have any intrinsic alarms.

Use the RFP window to Cancel Mute 
Alarms.

Backplane controller unit

DCT601 This alarm is used by Nortel 
Networks designers.

Information only, no action needed.

Table 78
Alarms  (Part 5 of 5)

Alarm
code Alarm description Maintenance act ion
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Web Alarm browser
The web Alarm browser has a circular log that provides information on a 
limited history of alarms. The Web Alarm browser records alarms at all times.

Figure 71
OTM web System Alarm browser
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Complete the following steps.

Windows Alarm Notification
Alarm Notification provides an alert by pagers, E-mail, and forwards SNMP 
traps to an upstream processor. For more information about the Alarm 
Notification, see Using Optivity Telephony Manager (553-3001-330).

Table 79
Alarm Code maintenance actions

Step Act ion

1 Using a web-based navigator, open the login screen and log in. Select the System 
Navigator. Select the Meridian 1 that supports the DECT system. Select Alarms.

Follow the instructions on page 24 to page 28.

2 Examine the code, and take the appropriate maintenance action.

See Table 78 on page 145.

END
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Figure 72
Alarm Notification
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Complete the following steps.

Event Monitor window
The Event Monitor window displays the system's Event Log, allowing all 
recent system events stored in the history file to be viewed. For more 
information about the Alarm management, see Using Optivity Telephony 
Manager (553-3001-330).

Figure 73
Event Log

Table 80
Alarm Notification

Step Act ion

1 Using Windows, open the login screen, login, select the Alarm Notification from the 
Utilities menu of the OTM Windows Navigator.

Follow the instructions on, page 24 to page 28.

2 Examine the Message ID, and take the appropriate maintenance action.

See Table 78 on page 145.

END
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Complete the following steps.

LED status for DMC8/DMC8-E and base station
LED status
The system LED status indicates the functioning of the DMC8/DMC8-E, 
base station power and card subsystem operation.

Table 81
Event Log

Step Act ion

1 Using Windows, login to OTM. Select the Event Log Viewer from the Maintenance 
menu of OTM Windows Navigator.

Follow the instructions on page 24 to page 28.

2 Examine the Application column.

DECT indicates a DECT event.

3 Examine the Data Group column.

Gives the Site name, PBX name, DECT name.

4 Examine the Message ID column.

Non-error logs range from 1 to 9999.

Error logs range from 10000 to 19999.

5 Examine the Message column.

Messages are the explanation of Message ID number codes.

END
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Table 82
DMC8/DMC8-E red LED status

Red LED 
State

Description Action

On The card is in one of the following states:

1 not programmed

2 disabled

3 has faults

1 Program the card. See 
page 132.

2 Re-enable the card. Use 
LD 32 ENLC l s c.

3 Replace the card. See 
page 157.

Flashes three 
times

Card is doing a self test. Wait.

Off 1 The card is in service if the yellow LED is 
off and the green LED is on.

2 The card has no power if all LEDs are off.

1 No action.

2 Restore power.

Table 83
DMC8/DMC8-E yellow/green LED status  (Part 1 of 2)

Yellow 
LED 
Status

Green 
LED 
Status

Description Action

Off Off Power down. Restore power.

On Off Hardware testing by boot 
program.

Wait.

On On Wait for download command by 
the boot program.

Wait.

On Loop‡ No valid main program found by 
the boot program. Card is 
continuously restarting.

Start firmware distribution with the  
DECT Manager.

Legend for LED action:
† Slow flash = 2 seconds On and 2 seconds Off
††Fast flash = 1 second On and 1 second Off
‡ Loop for no program = 3 seconds On and 0.25 seconds Off
‡ Loop for corrupted program = 12 seconds On and 0.25 seconds Off
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Slow 
flash†

On Faults caused by one of the 
following:

• software download in progress

• software distribution in 
progress

• subscription or configuration 
data is saving to the flash ROM

Wait.

Do not remove the card, removal 
corrupts the flashROM data.

Off Fast 
flash††

Card is synchronizing to the 
faceplate cable bus.

Wait.

Off Slow 
flash†

1 Card has no PARI, or has an 
incomplete PARI.

2 Card has detected
an error.

1 Contact the technical support 
group.

2 Replace the card. See 
page 157.

Off On Card is in service. No action required.

Slow 
flash†

Slow 
flash†

Simultaneous occurrence of:

• card has no PARI, or 
incomplete PARI and

• either software distribution is in 
progress or subscription or 
configuration data is saving to 
the flashROM

Contact the technical support 
group.

Table 83
DMC8/DMC8-E yellow/green LED status  (Part 2 of 2)

Yellow 
LED 
Status

Green 
LED 
Status

Description Action

Legend for LED action:
† Slow flash = 2 seconds On and 2 seconds Off
††Fast flash = 1 second On and 1 second Off
‡ Loop for no program = 3 seconds On and 0.25 seconds Off
‡ Loop for corrupted program = 12 seconds On and 0.25 seconds Off
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Remove and insert a DMC8 for maintenance

To remove, re-seat, or insert DMC8 card, perform the following actions:

• Backup the data from the DMC8 card to be removed.

• Remove the faulty DMC8 card.

• Insert a working DMC8 card.

• Restore the data to the DMC8 card that was replaced.

Table 84
Base station LED status

Green Description Action

Off No power. Check DMC8 to base station 
cables.

Flashes Input power present but no 
output power.

Check DMC8 LED Status and 
Alarm Reports.

Check DMC8 to base station 
cables.

On Power present and communications with DMC8 
established.

No action required.

CAUTION:  Service interruption
Do not bypass the DMC8-E or the DMC8 immediately to the left of the 
DMC8-E. A bypassed DMC8-E can not regenerate the faceplate bus signals 
in the left half of the shelf.

Although the separated left half of the shelf remains in synchronization, 
system performance decreases as follows:

• any calls passing through the separated part of the faceplate bus are 
dropped.

• handsets configured on a DMC in the separated half cannot make or 
receive calls through a base station in the other half.
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Backup a DMC8 card’s configuration and subscription 
information

Figure 74
DMC window  

Complete the following steps.

Table 85
Backup a DMC8 card’s configuration and subscription information

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window. Open the Boards 
window.

Follow the instructions on page 20 to page 30.

2 Select the DMC8 card.

Highlight the DMC8 card in the list.

3 Save the DMC8 data on the OTM.

From the Synchronization pull-down menu, click on Synchronize From. 

END
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 Remove a faulty DMC8 card

Figure 75
DMC8 card removal
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Complete the following steps.

Table 86
Remove a faulty DMC8 card

Step Act ion

1 Connect the maintenance bypass cable.

Plug the maintenance bypass cable into the Maint port of the DMC8 cards on either 
side of the DMC8card to be removed. 

2 Disconnect the faceplate cables.

Detach the faceplate cables from the DMC8 card to be removed and from the cards on 
either side of it. 

3 Remove the DMC8.

Release the card locking devices and lever the card out of the 
shelf backplane.

END
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Insert a serviceable DMC8 card

Figure 76
DMC8 card insertion
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Complete the following steps.

Table 87
Insert a serviceable DMC8 card

Step Act ion

1 Insert the DMC8 card.

Lever the card into the shelf backplane and latch the card 
locking devices.

2 Connect the faceplate cables.

Insert the faceplate cables into the DMC8 card just inserted and into the cards on 
either side of it.

3 Disconnect the maintenance bypass cable.

Remove the maintenance bypass cable from the Maint port of the DMC8 cards on 
either side of the replaced DMC8 card. 

END
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Restore subscription data to the serviceable DMC8 card

Figure 77
DMC window

Complete the following steps.

Table 88
Restore subscription data to the serviceable DMC8 card  (Part 1 of 2)

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the Boards 
window.

Follow the instructions on page 20 to page 30.

2 Select the DMC8.

Highlight the DMC8 in the list.
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Note: Restore only one DMC (Board) at a time.

Add a DMC8 card to a DECT system

Figure 78
Add a DMC8 card to the system

Save the DMC8 data on the OTM.

From the Synchronization pull-down menu, click on Synchronize To. 

Table 88
Restore subscription data to the serviceable DMC8 card  (Part 2 of 2)

Step Act ion
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Complete the following steps.

Table 89
Add a DMC8 card to a DECT system

Step Act ion

1 Connect the bypass cable.

Plug the bypass cable into the Maint port of the existing DMC8.

2 Insert the DMC8 card, with a terminating plug installed, into the top  port.

Lever the card into the shelf backplane and latch the card locking devices.

3 Connect the bypass cable to the added DMC8 card.

Plug the bypass cable into the Maint port of the added DMC8 card.

4 Remove the terminating plug from the existing card.

Remove the terminating plug from the bottom  port of the existing DMC8 card.

5 Connect the faceplate cable.

Insert the faceplate cables into the bottom  port of the existing DMC8 card and 
the added DMC8 card.

6 Disconnect the bypass cable.

Remove the maintenance bypass cable from the Maint port of the existing DMC8 card 
and the added DMC8 card.

7 Add the DMC8 card to the database.

Use the procedure on page 163.

END
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Reuse a DMC8 card in another DECT system

Figure 79
DMC window

Complete the following steps.

Table 90
Reuse a DMC8 card in another DECT system 

Step Act ion

1 Select the DMC8card to be reused.

Highlight the DMC8 in the list.

2 Delete the subscriptions from the DMC8 card memory.

From the File pull-down menu, click on Clear.

END
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Remove and re-install a base station for maintenance
Mute alarms on a base station

Figure 80
RFP window, and DECT Radio Fixed Parts properties window 
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Complete the following steps.

Cancel mute alarms on a base station
Complete the following steps.

Table 91
Mute alarm on a base station

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the RFP 
window.

Follow the instructions on page 20 to page 30.

2 Select the DMC8 to mute.

Highlight the DMC8 in the list.

3 Mute the alarms.

From the File pull-down menu, click on Mute Alarms, or click on the  icon.

Table 92
Cancel mute alarms on a base station  (Part 1 of 2)

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the RFP 
window.

Follow the instructions on page 20 to page 30.

2 Select the DMC8 to cancel mute alarms.

Highlight the DMC8 in the list.

END
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Disconnect and /Re-install a base station

Figure 81
Disconnect/re-install the base station

3 Cancel mute alarms.

From the File pull-down menu, click on Cancel Mute Alarms, or click on the  icon.

Table 92
Cancel mute alarms on a base station  (Part 2 of 2)

Step Act ion

END

553-8143a
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Note: After disconnecting the cable to the base station, wait for 60 
seconds before reconnecting another base station.

Complete the following steps.

Table 93
Disconnect/reinstall a base station

Step Act ion

1 Disconnect the RJ-45 cable, MDF side.

Unplug the RJ-45 cable from the wall socket of the RJ-45 box.

2 Disconnect the RJ-45 cable, base station side.

3 Remove the unserviceable base station from the mounting plate.

4 Re-install a serviceable base station on the mounting plate.

5 Re-connect the RJ-45 cable to the base station.

6 Re-connect the RJ-45 cable, MDF side.

END
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Firmware upload and activation

Figure 82
DECT Systems, DECT Firmware Upload, DECT Firmware Activation, Upload
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Complete the following steps.

Recover from a firmware upload failure
It is possible to upload DMC firmware with the V.24 port of a DMC8 card 
using a PC equipped with Z-modem protocol. During the upload, the DMC8 
card deletes the active and standby firmware, and stores the uploaded 
firmware as the active firmware. When the upload completes, the boot 
program starts the uploaded firmware.

Table 94
Firmware upload and activation

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window.

Follow the instructions on page 20 to page 30.

2 Open the Firmware upload dialog.

Select the Firmware pull-down menu, and click on Upload.

END
553-3601-301   Standard 5.00 September 2002



DECT System maintenance Page 173 of 196
Figure 83
Recovery upload to a DMC8 card

Complete the following steps.

Table 95
Firmware upload and activation  (Part 1 of 2)

Step Act ion

1 Configure the COM port settings.

baud rate = 19200

data bits = 8

parity = no parity

stop bit = no flow control

2 Connect the NTCW12AA cable to the DMC8 card to be uploaded.

Refer to Table 96 on page 174 for the NTCW12AA cable tip and ring connections.

3 Locate the OTM server COM port.

DMC8 card

  NTCW12AA
MDF to modem
      cable

 

PC with a Z-modem
     application
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Note: The BIX tip and ring connections shown in Table 96 on page 174 
correspond to standard BIX designation. The first pair are labeled T0 and 
R0. See DECT Installation Guide (553-3601-203), section “Planning 
and Designating the MDF”.

Connect the NTCW12AA cable connector into the PC COM port.

4 Unseat the DMC8 card.

Disconnect the DMC8 card from the shelf backplane.

5 Access Z-modem application; for example, Windows HyperTerminal.

Start > Programs > Accessories > HyperTerminal.

6 Initiate the file transfer.

Start the Z-modem application on the PC.

7 Activate the boot program.

Insert the DMC8 card into the shelf backplane. 

Table 96
NTCW12AA cable to MDF connections 

DMC8 Relay card 
MDF connection

Cable color
DB25 connector pin 

number
Signal designator

T1 Grey 8 V.24DCD

R2 Yellow 4 V.24RTS

T3 Blue 2 V.24TXD

R3 Red 3 V.24RXD

T4 Pink 7 V.24GND

Table 95
Firmware upload and activation  (Part 2 of 2)

Step Act ion

END
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Current RSSI Data
The Radio Signal Strength Indication (RSSI) shows interference and usage by 
a certain base station. A snapshot of the RSSI data is retrieved and stored in 
a file when the user requests it. If the file already existed, the new snapshot 
data is appended to the last snapshot data in the file.

Figure 84
Retrieve Current RSSI window, and Retrieve Current RSSI maps window 
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Complete the following steps.

Table 97
Current RSSI Data

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the Current 
RSSI Data window.

Follow the instructions on page 20 to page 30.

2 Select a DMC8 card or cards for RSSI information retrieval.

Scroll and highlight a TN in the Select DMC(s) for RSSI Retrieval: box.

3 Retrieve the RSSI data.

Click on the Retrieve RSSI now button.

4 Store the RSSI data.

Select a file location.

END
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RSSI file format
The data for each RFP is a nibble for indication of the RSSI value for each 
slot (24) for each carrier (10). This results in 10 (number of carriers) times 24 
(number of slots) nibbles equal to 240 nibbles (120 octets).

Figure 85
RSSI file format

----------------------------------------------------------------------------------------------------------------------------------------------------------------------------
------------------------------------------------------------------------------

Wed Apr 18 16:00:42 CEST 2001
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------
------------------------------------------------------------------------------

DMC TN : 48 1 07

RFP 1 :
0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF5F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F3F5FFF5FF
F0F0F0FFF0FFF0F1F0FFF0FFF0F0F0FFF0FFF0F0F0F0F0F1F0F0F0F0F0F0F0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0F
FF0F0F0FFF0FFF0F0F0FFF0FFF

RFP 2 :
F0FFF0F0F0FFF0FFF4F0F0FFF0FFF0F0F0FFF0FFF8F0F0FFF0FFF0F0F0F0F0FFF3F0F0F0F0FFF0F0F0FFF0FFF0F0F0FFF0F0F0F0F0F
FF0F0F0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF3F5F5FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0FFF0FFF0F0F0
FFF0FFF0F0F0FFF0FFF0F0F0FF
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Start/stop User Performance Collection, Equipment 
Performance Collection

Figure 86
Performance Collection window and Select location dialog 
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Complete the following steps.

CAUTION:  Service interruption
Check to ensure the Performance Collection is not using all the OTM 
server storage space.

Table 98
Start/stop User Performance Collection, Equipment Performance Collection 

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window, and open the 
Performance Collection window.

Follow the instructions on page 20 to page 30.

2 Select a collection name.

Enter a name or browse for a collection name.

3 Select the check box User Performance Collection or Equipment Performance 
Collection, or both.

Click on the check box.

4 Select a collection period.

Note:  The User Performance Collection period and the Equipment Performance 
Collection period are independent of each other.

Highlight a time from the Collection Period box.

5 Select a DMC8 card.

Highlight a TN from the DMC TN box.

6 Start the collection.

Click the Start button.

7 Stop the collection.

Click the Stop button.

END
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Equipment Performance Collection
Equipment Performance Collection file format
File name: (for example) epm-brdPP_YYYYMMDDHHMMSS.xml, 
epm-brd24_20010418170920.xml. 

DTD Document Type Definition: <<Epm.zip>> 

Counter description (in the DTD order) 

See “Equipment Performance Collection file sample” on page 191
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Board (DMC8) statistical performance data    

Table 99
Board statistical performance data 

Counter Description

1 Indicators, not used

2 Number of dropped calls

3 Number of page failures

4 Number of page retries

5 Number of page requests

6 Number of page rejects

7 Number of voice calls

8 Number of message call

9 Number of dropped voice calls

10 Number of dropped message calls

11 Number of dropped voice calls in active phase

12 Number of dropped message calls in active phase

13 Number of dropped voice calls in passive phase

14 Number of dropped message calls in passive phase

15 Number of successful supplementary service calls

16 Number of supplementary service calls with no response

17 Number of supplementary service call rejects

18 Number of slip events on BBC highway A

19 Number of slip events on BBC highway B

20 Number of DECT clock errors
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RFP (base station) statistical performance data 

Table 100
RFP statistical performance data  (Part 1 of 2)

Counter Description

1 Indicators: 1 = 6 Channel RFP, 2 = 12 Channel RFP, 3 = Unknown

2 Number of times BMC overrun occurred

3 Number of times TBC established

4 Number of NT Handshake failures

5 Current radio head error code. See Radio Head Errors section below.

6 Number of units of 100 ms since last radio head error

7 Bit counter pre-set (the measured RFP cable delay in DECT bits)

8 Number of times dummy bearer 0 was set-up

9 Number of times dummy bearer 1 was set-up

10 Number of times dummy bearer 0 was replaced

11 Number of times dummy bearer 1 was replaced

12 Number of frames with corrupted A fields (R-CRC check failed)

13 Number of frames with corrupted B-fields (X-CRC check failed)

14 Number of bad syncs 

15 Number of muted frames

16 Total duration of calls using this RFP in units of 10 ms

Radio Head Errors

17 Number of times Local Receiver Signal Missing

18 Number of times Local Loss Receiver Slot Sync

19 Number of times Local Loss Receiver Frame Sync.

20 Number of times Local Bit Error Rate Bad

21 Number of times Remote Receiver Signal Missing

22 Number of times Remote Loss Receiver Slot Sync

23 Number of times Remote Loss Receiver Frame Sync
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RFP (base station) Error Codes
Error codes are shown in decimal and in (hexadecimal). 

24 Number of times Remote Bit Error Rate Bad

25 Number of times Synthesizer Out Of Sync

26 Number of times Power Amp Out Of Order

27 Number of times Round Trip Delay Changed

28 Number of times RFP Synthesizer Type Changed

29 Number of times LFC Out Of Sync With BMC

30  Number of times Error Due To Sync Port Mutation

Table 101
RFP Error codes  (Part 1 of 2)

Error code Description

1 (0x01) Local Receiver Signal Missing

2 (0x02) Local Loss of Receiver Slot Sync

3 (0x03) Local Loss of Receiver Frame Sync

4 (0x04) Local Bit Error Rate Bad

5 (0x05) Remote Receiver Signal Missing

6 (0x06) Remote Loss of Receiver Slot Sync

7 (0x07) Remote Loss of Receiver Frame Sync

8 (0x08) Remote Bit Error Rate Bad

9 (0x09) Synthesizer Out Of Sync

10 (0x0A) Power Amp Out Of Order

11 (0x0B) Round Trip Delay Changed

12 (0x0C) RFP Synthesizer Type Changed

Table 100
RFP statistical performance data  (Part 2 of 2)

Counter Description
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RFP-Channel occupation performance data
The 13 RFP-channel occupation counters give the number of seconds that n 
RFP channels were free (n = 0 – 12). 

Backbone-Channel occupation statistical performance data
The 33 Backbone-channel occupation counters give the number of seconds 
that n backbone channels were free (n = 0 – 32). 

Speech-Channel occupation statistical performance data
The 33 Speech-channel occupation counters give the number of seconds that 
n speech channels were free (n = 0 – 32). 

User Performance Collection 
User Performance Collection file format
File name: upm-brdPP_YYYYMMDDHHMMSS.xml
Example: upm-brd24_20010418170924.xml 

DTD Document Type Definition: <<Upm.zip>> 

See “User Performance Collection file sample” on page 193

13 (0x0D) LFC Out Of Sync With BMC

14 (0x0E) Error Due To Sync Port Mutation

255 (0x0FF) No Error

Table 101
RFP Error codes  (Part 2 of 2)

Error code Description
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Statistical Performance Data

Table 102
Statistical Performance Data

Counter Description

1 Indicators, not used.

2 Number of page failures.

3 Number of page retries.

4 Number of page requests.

5 Number of page rejects.

6 Number of voice calls.

7 Number of message calls.

8 Number of voice calls, dropped in passive state.

9 Number of voice calls, dropped in active state.

10 Number of message calls, dropped in passive state.

11 Number of message calls, dropped in active state.

12 Number of handovers.

13 Number of failed handovers.

14 Number of aborted handovers.

15 Number of delayed handovers.

16 Current Circuit Number (0xFF, if none).
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Set parameters

Figure 87
DECT System Properties – Parameters tab
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Complete the following steps.

Password recovery
The DECT System password can be changed by a customer and the 
distributor managing the system would not know the changed password. The 
password could be damaged in the OTM database by a disk crash and not 
backed up, or the password can be forgotten. Passwords cannot be accessed 
from the OTM.

The OTM provides a mechanism allowing the password to be reset to the 
factory password. The password can be changed in the DECT system and the 
OTM DECT database, or in the OTM DECT database only.

Table 103
Set parameters

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system, 
Launch the DECT application. Open the DECT Systems window. Open the Properties 
dialog, and click on the Parameters tab.

Follow the instructions on page 20 to page 30.

2 Select the parameter.

Select a pull-down menu item, and click Apply.

END
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Figure 88
DECT Systems window, DECT Systems Properties, Change DECT Password
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Complete the following steps.

Table 104
Password recovery

Step Act ion

1 Using Windows, login to OTM. Select the Meridian 1 that supports the DECT system. 
Launch the DECT application. Open the DECT Systems window. Open the Properties 
dialog, and click on the General tab.

Follow the instructions on page 20 to page 23.

2 Select password change.

Click on Change Password.

3 Change to the factory default password.

Note:  The default is case sensitive.

Type Arsenal in the New password box.

4 Confirm the password.

Type Arsenal in the Confirm new password box.

5 Set up for a password change the on the DECT system.

Remove the DMC8 Relay card, and reinsert the DMC8 Relay card.

6 Connect to the DECT system within five minutes.

From the Applications pull-down menu click on Connect or the  (green) icon.

 
END
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194
Appendix 1: Performance Collection
file samples
Equipment Performance Collection file sample

<?xml version="1.0"?> 
<file> 
<header> 
<systeminfo PARI="44446666"/> 
<boardinfo boardnumber="24"/> 
<package package_id="45100105"/> 
</header> 
<data> 
<boardstat> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0</

counters> 
</boardstat> 
<rfpinfo> 
<rfpstat rfp="1"> 
<dateandtime>2001,1,24,19,50,9,0</dateandtime> 
<counters>1,0,0,0,8,420,0,1,1,0,0,0,0,0,0,0,0,0,0,0

,0,0,0,1,0,0,0,0,0,0</counters> 
</rfpstat> 
<rfpstat rfp="2"> 
<dateandtime>2001,1,24,19,50,13,0</dateandtime> 
<counters>1,0,0,0,8,420,0,1,1,0,0,0,0,0,0,0,0,0,0,0
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,0,0,0,1,0,0,0,0,0,0</counters> 
</rfpstat> 
<rfpstat rfp="3"> 
<dateandtime>2001,1,24,19,50,13,0</dateandtime> 
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0

,0,0,0,0,0,0,0,0,0</counters> 
</rfpstat> 
<rfpstat rfp="4"> 
<dateandtime>2001,1,24,19,50,19,0</dateandtime> 
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0

,0,0,0,0,0,0,0,0,0</counters> 
</rfpstat> 
</rfpinfo> 
<rfpchanocc> 
<rfpchocc rfp="1"> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
<rfpchocc rfp="2"> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
<rfpchocc rfp="3"> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
<rfpchocc rfp="4"> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0</choc> 
</rfpchocc> 
</rfpchanocc> 
<bschanocc> 
<bchanocc> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0
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,0,0,0,0,0,0,0,0,0,434</choc> 
</bchanocc> 
<schanocc> 
<dateandtime>2001,1,24,19,50,6,0</dateandtime> 
<choc>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0

,0,0,0,0,0,0,0,0,0,434</choc> 
</schanocc> 
</bschanocc> 
</data> 
</file>

User Performance Collection file sample
<?xml version="1.0"?> 
<file> 
<header> 
<systeminfo PARI="44446666"/> 
<boardinfo boardnumber="24"/> 
<package package_id="45100105"/> 
</header> 
<data> 
<ppstat RecNum="2"> 
<dateandtime>2001,1,12,18,17,37,0</dateandtime> 
<ipui>40110000E5A97B7F84</ipui> 
<dnr>20801</dnr> 
<counters>0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,255</counte

rs> 
</ppstat> 
</data> 
</file> 
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